
• About Focus VoiceCalendar™

So you purchased the ultimate multimedia machine, a Macintosh!  Now you 
need to find an application which would let you unleash the multimedia 
power of your computer.  Almost every Mac built since the introduction of the
original LC in late 80's has built in sound recording capability.  Until now most
owners of such computers have been using that feature to record fancy 
alarm sounds!

VoiceCalendar a digital calendar.  First of its kind, it is a calendar for people 
who hate to type! or people who appreciate efficiency.  It allows the user to 
enter daily messages by specifying the date, time, occasion, record and save
a voice message  with clicks of mouse all without typing a single word!.  User
can also view the entire month, select any date and play back any of the 
messages using their mouse.  

The VoiceCalendar features three method by which the user can be notified 
of a previously recorded reminder.  The first method is a blinking icon in the 
menu bar.  This method is ideal for environments where any amount of noise 
could be undesirable.  The second method is a soft bell sound which would 
ring approximately every five seconds to inform the user there is a pending 
message.  The final method allows the user to hear the actual recorded 
message for the reminder.  User can select any or all possible combination of
these three method according to their needs or preferences.  

Users can record up to 32,000! messages for any day and each voice 
message could be of any length.  Another important feature of the 
VoiceCalendar is that it allows the user to optionally run the calendar every 
time they start their computer.  This startup feature is achieved without 
utilizing any control panels or extensions therefore, it will not cause any 
conflicts with the any of the installed system files.

•• System Requirements

The VoiceCalendar application requires a minimum system configuration of:



    • Hardware: 68020, 68030, or 68040 or Power PC Macintosh. (Any of the 
LC, Powerbook, Quadra, Centris, Performa, Power Macintosh families of 
Macintosh computer.)

    • System 7 and higher.

    • Sound manager 3.0 or later for best results.

    • 400 K of free memory.

    • Apple built-in or third party sound input capability and a microphone for  
recording the voice messages.

If you do not have sound manager 3.0, you may obtain a copy through on-
line services such as America Online, CompuServe, Applelink, eWorld, and 
the Internet.  Or you may contact your favorite Apple authorized dealer for 
information on how to obtain a copy.

•• How to use the on-line help module:

The on-line help module consists of two lists.  The list on the left, is the 
topics.  User can select a topic by scrolling up or down and clickin the desired
subject.  The text field on the right would display the help text associated list
item selected.  The help window is a standard window which can be dragged 
around by click-dragging in the title bar.  User can quit the help module by 
clicking the close (go-away) box on the top left corner.

•• Quick Reference:

This section can be used as a quick reference for setting up an alarm time, 
date, and occasion and message.

• To record a new appointment:

1) From the main window, use the year, month, and day buttons to navigate 
to the desired date.



2) Select the new button from the main window or if there are no entries for 
that day, double click on the day desired to activate the new entry window.

3) Set the desired alarm time using the date buttons in the new entry dialog. 

4) Select the record button to begin recording a voice message.

5) After the completion of the recording process, press done to return to the 
new entry dialog.  At this point your reminder and the accompanying voice 
message has been recorded and added to the database.

6) When you are back in the new entry window you have the following 
options:

    - Press help button for more help.

    - Press the done button to return to the main window.

    - Set up a new time and press the record button to record a new message. 

• To view a new appointment:

1) From the main window, use the year, month, and day buttons to navigate 
to the desired date.

2) Select the view button from the main window or double click on the day 
desired to activate the view window.

3) Click on any of the recorded reminders and select the play button to listen
to the reminder.  User can optionally double click on any reminder to play 
back the corresponding voice massage.

•• How to install VoiceCalendar

Please follow these steps to install VoiceCalendar in the Apple menu:

1) Create a Folder by selecting "New Folder" from the "File" menu in Finder.  
Name this folder "VoiceCalendar Folder".

2) Drag the VoiceCalendar application over the folder's icon.  Now the 
application is inside the folder.  This folder is where the main VoiceCalendar 
application must remain from now on.



3) Open the newly created folder by double clicking on it.  Select the 
VoiceCalendar by clicking on the application once.  

4) In the "File" menu of the Finder select "Make Alias".

5) Open the system folder on your drive.

6) Drag the icon of the alias that you created in step 4 onto the "Apple Menu 
Items" folder.

7) Click on the "Apple" menu in the Finder and select the VoiceCalendar alias 
that you place there.

8) Enjoy!!

•• The Menus Section has the following parts:

    -Apple Menu
    -File Menu
    -Edit Menu
    -Preferences Menu
               -Capture Preferences
               -Notification Menu
               -Compression Menu
               -Windows Menu
               -Volume Menu
               -Run at startup

For more details on each of the above see the corresponding help sections.

•• Apple Menu:

• About VoiceCalendar:
This menu item displays the information available about the program and the
author.

• Help:
Use this menu item to activate the on-line help module.  This module has 
extensive help text describing various features of the VoiceCalendar and how
to fully utilize them.  See the "How to use the On-line help module" section 
for more details.



•• File Menu: 

• New Memo: 
This menu item allows the user to record new message(s) to disk. Upon 
selection, user is presented with a dialog which allows selection of the time 
for the message and record the voice message  for the specified time.  See 
"New Entry Window" section for more details.

• Lookup Memo: 
This menu item allows the user to play back a previously recorded message 
from disk. Upon selection, user is presented with a dialog which allows 
selection of the message to be played.  When this menu item is selected, all 
recorded messages for the currently selected day, month, and year would 
appear in the lookup window.  See the "Lookup Window" section for more 
details.

• Close: 
Selecting this menu item would close the front most window.  This menu Item
only works with new entry and lookup windows.  The main window and the 
miniature windows are considered "root" windows and therefore one of them 
must remain open at all times.

• Quit: 
This menu item quits the VoiceCalendar application and releases the memory
used for the application back to the system and finder.

•• Edit Menu: 

This menu is implemented for the desk accessories use (required for their 
proper operation) only and is not used by VoiceCalendar application. 

•• Preferences Menu: 

This menu allows the user to customize the behavior of the VoiceCalendar 
application and has the following items:

               -Capture Preferences



               -Notification Menu
               -Compression Menu
               -Windows Menu
               -Volume Menu
               -Run at startup

For more details on each of the above see the corresponding help sections.

•• Capture Preferences:

Upon selection, this menu item would save the following settings:

            * All window locations.
            * To startup in shrink or expand mode for the main window.
            * The desired compression level.
            * Whether or not to run VoiceCalendar the next time the computer is 
turn on or restarted.
            * Notification method(s) selected.
            * Sound volume level for playing sound.

For more details on each of the above see the corresponding help sections.

•• Notification Menu: 

• Menu Bar Notification:
Selecting this option would cause an icon to flash in the menu bar on top the 
Apple icon in the top left corner of the screen.  This option allows the user to 
receive a signal from the calendar which would not interfere with any on 
going task that the user is involved with at the time.  For example any audio 
sounds would be undesirable in a business meeting or during a phone 
conversation.

• Audio Notification:
Selection of this menu item would cause the VoiceCalendar to play a soft ring
every five seconds when the reminder is due.  This provides the user with 
audio feedback while keeping the playback of the actual message optional.  
This handy when the message contains private or sensitive material and 
therefore the playback of the actual message would be at the user's 
discretion.

• Play Actual Message:
By selecting this option, user can require the VoiceCalendar to go ahead and 
play the actual message when the reminder becomes due.



User is free to choose all or any combination of the three options above to fit 
their type of needs and requirements.

•• Compression Menu: 

VoiceCalendar allows the user to select the desired compression level at the 
time a reminder is created.  Compressing and decompressing of the message
is done transparently and once the desired level is selected and the 
preferences are captured, user never has to do deal with compression again 
and everything is done automatically thereafter.  Compressing the recorded 
sound would help to save disk space and allows longer messages.  At 22 KHz
sampling rate, with no compression each second of recorded sound will take 
approximately 22k of disk space.  With 3 to 1 compression one second of 
sound will take 7.6k of space and at 6 to 1 compression only requires 3.8k of 
disk space.  The disk space used to store a message is greatly reduced 
through compression, however the compression process will somewhat 
reduce the fidelity of sound recorded.  The 3 to 1 compression offers a 
compromise between disk space and quality of sound.

•• Volume Menu

The overall loudness level for the sound playback can be adjusted from this 
menu.  The values can be adjusted from 10 to 100 percent of the maximum 
volume in steps of ten percent.

•• Windows Menu

• Stack:
Selection of this menu item would stack up all open windows.  This feature 
would allow the user to quickly navigate back and forth between all of the 
open windows without them being covered by any other windows.

• Shrink:
The Shrink menu item would close all windows and activate a miniature 
window.  This action would achieve two tasks.  This option would save 
desktop space and additionally, it would use less processing power and 
therefore give other running applications more time to perform their tasks.  It
is suggested that the user select this idling option whenever VoiceCalendar is
not being used.  The user will still be notified of any pending messages even 
when the main window in miniaturized.



• Expand:
Selection of this menu item would undo the option "Shrink" and allows 
entering new entries and looking up recorded messages by returning to full 
view.

•• Run At Startup
This menu item would provide the user with an option to automatically start 
the VoiceCalendar application every time the computer is turned on or 
restarted.  Upon selection, the File "Focus VoiceCalendar Startup" is placed in
the "Startup Items Folder" in the "System Folder" and a dialog is displayed 
stating that such file is placed there.  The option of starting at startup if off 
by default and can be activated or deactivated utilizing this option from the 
preferences menu.

•• The Windows Section has the following parts:

    - Main Window
    - New Entry Window
    - Lookup Window
    - Miniature Window
    - Help Window
    - Notification Window

Click on the corresponding item in the help module list for more details.

•• Main Window

    This window is the central window of the VoiceCalendar program.  On the 
right side there are 12 buttons each labeled for a month of the year.  The 
bottom row has seven buttons labeled for years from 1995 to 2000.  At the 
center, the days of the month are displayed for the selected month and year.
At startup the current date is selected.  User can select a date for new entry 
or lookup by simply clicking in the desired day, month, and year and then 
selecting the action they wish to perform.  On the top right corner is the 
digital display of the current date and time. Finally there are a series of 
navigating buttons stacked on the left.  These button from top to bottom are:

• Focus Softworks Button:
Pressing this button would bring up the portion of the help module describing
how to reach Focus Softworks for comments and suggestions.



• New Button:
This button would activate the new entry window.  From the entry window 
user can enter a new message for any desired date and time.  See the 
description of this window in the "New Entry Window" section.

• Shrink Button:
This button shrinks the main window allowing the user to save precious 
desktop space and processor time.  For more information, see the "Miniature 
Window" section later in this module.

• Lookup Button:
This button (with a magnifying glass) activates the lookup window from 
which the user can review entered messages for the currently selected date. 
If the currently selected day has no recorded message, pressing this button 
would have no effect.  See "Lookup Window" for more details.

• Help Button (?):
Clicking this button will bring up the on-line help module where the "Main 
Window" and its components are described.  From this point user can 
navigate to other section of the module.  Please see the "How To Use This 
Help Module" for more information.

• Trash Button:
Pressing this button allows the user to delete all entries recorded for any 
particular day.  After clicking this button, user is presented with a dialog 
requesting confirmation before deleting the messages.  Pressing Yes would 
erase all messages for the selected day and free up disk space used.  It is 
suggested for the user to do so for outdated messages.  To see how to erase 
individual messages for any day see the "Lookup Window" description.

•• New Entry Window:

This window allows user to enter messages for any day.  User can select a 
target day by using a series of buttons on the top labeled "Year", "Month", 
"Day", "Hour", and "Minute".  Additionally, a series of "Occasions" are 
displayed in a list below the aforementioned buttons.  Simply scroll to a 
desired occasion and click in it to select it.  Control buttons located at the top
of the window which control the desired action are:

• Done:
Pressing this button would close related files and the new entry window and 
return the user to the main window.

• Help (?):
Clicking this button will bring up the on-line help module where the "New 
Entry Window" and its components are described.  From this point user can 



navigate to other section of the module.  Please see the "How To Use This 
Help Module" for more information.

• Record:
After selecting the date and time for the message pressing this button would 
bring up a record dialog which allows the user to record a voice message.  
This record dialog uses the same user friendly features as the sound control 
panel which comes with system software.  After recording, previewing, and 
editing pressing the Done button would save the message.

•• Lookup Window:

This window allows user to review entered messages for any day.  User can 
select the desired day from the main window.  Additionally, all recorded 
messages are displayed.  Simply scroll to a desired message and click on it 
once to select it.  Next click play button described later in this section to hear
the voice message.  The digital display at the top show the date for which 
messages are listed.  User can adjust the volume of sound by using the "+" 
and "-" buttons labeled Volume.  The volume control is set to 50 percent by 
default.  Control buttons located at the right side of the window which control
the desired action are:

• Stop:
Pressing this button would stop the voice message currently being played.  If 
there is no playback in progress pressing this control button would have no 
effect.

• Play:
This button would allow the user to start the playback of the currently 
selected voice message  from the lookup list.  Pressing this button again 
before the message is finished would cause the message to start from the 
beginning.

• Done:
Pressing this button would close related files and return the user to the main 
window.

• Help (?):
Clicking this button will bring up the on-line help module where the "Lookup 
Window" and its components are described.  From this point user can 
navigate to other section of the module.  Please see the "How To Use This 
Help Module" for more information.

• Trash Button:
Pressing this button allows the user to delete the currently selected voice 



message.  After clicking this button, user is presented with a dialog 
requesting confirmation before deleting the message.  Pressing Yes would 
erase the message for the selected item and free up disk space used.  It is 
suggested for the user to do so for outdated messages.  To see how to erase 
all messages for an entire day see the "Main Window" description.

•• Miniature Window:

From the main window, user can activate this window which allows the user 
to save precious desktop space.  Furthermore, since other application can be 
used concurrently with VoiceCalendar miniaturizing the main window would 
give other applications more processing time.  User can return to the main 
window by clicking in the expand button located on the upper right corner of 
the window.  Current time and date is displayed in the digital portion of the 
window.  User can drag the miniature window around by click-dragging 
anywhere in the display area except the expand button. 

•• Help Window:

This window contains all the on-line help text available for the application.  
The window is a standard Macintosh application window with two sections.  
First section is the topics and the second is the text associated with the topic.
User can activate the on-line help module by selecting the "Help" menu item 
from the Apple menu.  See the "How to use the On-line help module" section 
on more details on the usage of this feature.

•• Notification Window:

When a previously recorded reminder becomes due, the VoiceCalendar would
take certain actions depending on user selected options.  These actions 
could compromise a menu bar notification, a soft audio ring, or playback of 
the actual message for that particular reminder.  When either or all of these 
action are taken, VoiceCalendar would put up a dialog which provides the 
user with four options.  Namely, to move, playback, remove, or delay the 
reminder for five minutes.  User can select playback option as many times as
required to listen to the actual message.  The remove option allows the user 
to tell the program that the message is acknowledged and that the 
VoiceCalendar can go ahead and remove it from records and delete it.  The 
delay option allows the user to choose to deal with the message at later time
if they are currently busy with another task.  Finally, the move option allows 
the user to move the reminder to another date and time.  This feature can 
become handy in two situations.  First, if the user wishes to delay the 



message by any amount other than the five minutes with the Delay button, 
can do so using the move button.  Secondly, the move button can be used to
create reoccurring events.  For example, if you placed a reminder for a 
birthday, when VoiceCalendar flags stating that it is due, you can simply 
move it to the next year!  This way you can save time by not having to go 
back and create a new reminder for the next year.  This can also apply to 
paying the Rent, annual physical exam, anniversary, etc.

•• Double clicking feature:

To further make the navigation through VoiceCalendar easier, several steps 
can be executed by simply double clicking.  These steps are:

• Entering and viewing messages from main window

first click on the year followed by the month desired and the double click on 
the day.  If there are no messages for that day the double click would bring 
up the new entry window.  On the other hand, if there is one or more 
messages recorded on that particular date, the lookup window would be 
brought to the front.

• Recording a message from new entry window

After the date and time of the message are adjusted, user can directly 
activate the record dialog by double clicking on the desired occasion.

• Playing back a message from lookup window

After the lookup window is brought to the front double clicking on any of the 
recorded messages would automatically initiate playback.

•• How to record longer messages:

There are two way for the user to record messages that are longer.  These 
methods can either be used individually or in combination.  These methods 
are:

• Method 1: More Memory



The VoiceCalendar memory partition size is 400 kilobytes.  Increasing this 
value would result in more memory to be used for recording.  To change the 
partition to a higher level follow these steps:
1) Select the VoiceCalendar application icon by clicking on it once.
2) From the finder's "File" menu select the "Get Info" menu item. 
3) In the box labeled "Preferred Size" enter a number greater than 400 for 
example, 600.
4) Click in the go-away box of the Get Info window.
5) Start the VoiceCalendar application.

• Method 2: More Compression

The default compression level for VoiceCalendar is 3 to 1.  By increasing to 6 
to 1, user can double the record time.  On the other hand, if user chooses to 
turn compression off for more fidelity the record time is cut to 1/3.  For more 
detailed explanation of the compression feature see the section on 
"Compression Menu".

It is suggested that the user experiment and using either or both methods to 
achieve a combination of memory size and compression level best suited for 
their needs.

•• Warranty/Liability

This software is released on an "AS IS" basis. The author and Focus Softworks
provide no warranty of any sort. The user of this software assumes complete 
responsibility for any direct or indirect damages due to use or misuse of this 
software.  This program including but not limited to the code is copyrighted 
by Afshin Latifi and Focus Softworks and is NOT public domain (strictly 
enforced).  It may not be disassembled copied or modified or otherwise 
reduced to human comprehensible form.  The Focus VoiceCalendar program 
or any portion of the program may not be distributed or renamed or resold 
for any purpose and should be considered propriety asset own solely by 
Afshin Latifi and Focus Softworks.

•• How to reach the author

Please E-Mailed questions, comments, bug reports to me at:

America Online :Latifi
Internet : latifi@aol.com



or by US Mail to the address displayed in the introductory screen.

•• How to order a fully functioning version of VoiceCalendar

To order VoiceCalendar, select the print order form option from the 
introductory screen. For fastest delivery please print clearly and fill all 
appropriate fields.  Registration for the full version entitles the user to FREE 
phone support.  Additionally , registration would give you access to lifetime 
free updates and revisions of the application when you download it from any 
Bulletin Boards, America Online, or the Internet.

•• Commercial and Shareware Distribution

This or any of other works of this author and Focus Softworks shall not be 
distributed for profit without prior written consent of the author (strictly 
enforced).  Requests for commercial distribution can be submitted to the 
address displayed in the introductory window.  

•• Other Focus Softworks products ••

The following are the list of products at the time of release of this version of 
Focus VoiceCalendar™:

• MicroRecorder™- 
- Is a sound player which allows background sound playback on any 

Macintosh with color capability in AIFF format.  It features unlimited record 
and play back time, repeated playback, on-line help, volume adjustment, and
audio selection.  The audio selection allows the user to play back a portion or
the entire sound.  This program has three dimensional controls, animation, 
and digital display featuring playback time, audio selection, volume level. 
(20 USD+5 Shipping)

• MicroRecorder Pro™- 
- Based on the popular MicroRecorder, the pro version has the same 

features with the addition of pitch control, REAL TIME! display of the sound, 
Stereo capability, and left/right channel control.  Furthermore, MicroRecorder 
Pro supports AIFF, system 7 sound file, and PC/Windows wave format.  The 
support for PC/Windows format allows the user to import their favorite sound 
from the other platform.
(32 USD+5 Shipping)

• AudioClock™- 
- Is a digital Alarm Clock.  It is a Clock for people who appreciate 



efficiency.  It allows the user to enter daily messages by specifying the time, 
occasion, recording the voice message and save with clicks of mouse all 
without typing a word!.  User can also preview the messages using their 
mouse. 
(25 USD+5 Shipping)

• VoiceCalendar™- 
- Is a digital calendar.  First of its kind, it is a calendar for people who 

hate to type! or people who appreciate efficiency.  It allows the user to enter 
daily messages by specifying the date, time, occasion, recording the voice 
message and save with clicks of mouse all without typing a word!.  User can 
also view the entire month, select any date and play back any messages 
using their mouse. 
(32 USD+5 Shipping)

• Focus DictationMachine™-
      - is functionally equivalent to a transcribing device.  It allows continuous 
background recording and playback of sound from hard disk.  This would 
allow you to work with other programs while the sound is being recorded or 
played in the background.  Among the key features of the DictationMachine 
are:

*- Full asynchronous Record and playback of sound. 
*- 100 percent user configurable voice activated recording (VOX). 
*- Support for 3:1 and 6:1 compression of the recorded sound.
*- Fast forwarding and rewinding of sound being played.
*- Volume adjustment.
*- Pitch adjustment.
*- Threshold adjustment.
*- Delay adjustment.
*- Quick Skip feature allowing to instantly to jump to any section of tape.
*- Insert and remove any portion of tape with a click of mouse.
*- Excellent 3D graphical interface and animation!
*- Full utilization of the notification manager.
*- Real-time sound display for record and playback states!!
(37 USD+5 Shipping)

• Focus Comatose ™- 
- Is an application which will help you prolong the life of your computer 

and save on the electricity bill while doing so!!  It allows the user to put their 
computer to sleep rather than shut down the entire system.  Before 
Comatose this feature was only available to Powerbook users.  It works with 
all Macintoshes Plus and later running system 7 or later and 100K of memory.
Comatose would spin down all hard drives on all SCSI buses and turn the 
screen off.  If you have an energy star compliant monitor, the blacking of the 



screen allows the monitor to power down internally also to add to the savings
in electricity. 
(20 USD+5 Shipping)

• Focus TeleContact ™- 
- Is the Mercedes of file transfers!!  It was created with the following

goals in mind:

1) To make sending and receiving files as effortless as a simple telephone
call.   This task is achieved by automatically configuring and adjusting the
parameters transparently such that the user is relieved of the cumbersome
task of setting baud rate, bit parity, compression method, auto-answer and
maximum transmission, etc.

2) Provide an elegant yet simple and intuitive interface to the file transfer
process.  As it would be described later in this manual, user can simply drag
and drop any file on to the TeleContact and have it send the contents to any
location in the world!

3) Combine the functionality of a modem protocol and the ease of use of a
fax machine with some added features  not  offered by either  methods of
communication.  For example, when a document is faxed, a picture of the
document is sent to the target location.  Should the recipient of the faxed
document wish to make changes to the document, The have to retype the
text or use some sort of OCR program to extract the text which often leads to
loss of formatting.  Using TeleContact, the recipient can simply use their word
processor or  graphics program to edit  or  print  the document at  a higher
resolution that of the 200 dpi offered by a fax machine.
(42 USD+5 Shipping)

Look for these and our new products on America Online, your favorite 
bulletin boards and the Internet.  

For latest version information or questions see "How to reach the Author" 
section.

AudioClock, MicroRecorder, MicroRecorder Pro, VoiceCalendar, TeleContact, 
Comatose and DictationMachine are trademarks of Focus Softworks.

Copyright © 1993,1995 Focus Softworks and Afshin Latifi. 
All rights reserved worldwide.

All other products mentioned herein are trademarks of their respective 
holders.


